Consultant job planning diary

Version 6.3

Operating manual

This job planning diary was written in Microsoft Excel by Dr Mark Porter, consultant anaesthetist at the University Hospital in Coventry. It is freely distributed but you are advised to read the Conditions of Use and the rest of the manual describing how the diary works and the assumptions that I have made.

© Dr Mark Porter FRCA, 2003-08.

Contents

Introduction ................................................................................................................................. 1
Conditions of use ...................................................................................................................... 2
Job planning – what they say ..................................................................................................... 2
Upgrading from previous versions ............................................................................................. 2
Versions .................................................................................................................................... 3
Completing the diary .................................................................................................................. 3
Short breaks ............................................................................................................................... 3
Adding more weeks ................................................................................................................... 4
Job codes .................................................................................................................................. 4
User-definable fields .................................................................................................................. 4
On-call working ......................................................................................................................... 4
Substituted clinical time .......................................................................................................... 4
Premium time ............................................................................................................................ 5
Compensatory rest .................................................................................................................... 5
Additionally-remunerated work ............................................................................................... 5
Non-work activity ..................................................................................................................... 6
Adding up programmed activities ............................................................................................. 6
Producing an average ................................................................................................................. 6
Recording working days .......................................................................................................... 6
Bank holidays ........................................................................................................................... 6
Part-time contracts ................................................................................................................... 6
Additional programmed activities ............................................................................................ 7
Clinical academic work ............................................................................................................ 7

Introduction

You are most strongly advised to read the relevant advice before completing this job planning diary; and also the advice on how to use the results for agreeing a consultant contract. More information will be needed for job planning. See the advice available on the BMA web site. The NHS Modernisation Agency has a similar diary and useful advice.

You may also wish to consult your trades union or professional association for personal advice.

British Medical Association

http://www.bma.org.uk/

Diary web link

http://www.consultantscommittee.info/

This diary is designed to support the 2003 consultant contract in England. It will be useful for job planning in other countries but I have not designed this diary to accord with the precise details of other national contracts.
Conditions of use
The spreadsheet is freely distributed without warranty as to accuracy. You may distribute it so long as you leave my copyright notice and name on the pages. You may enter data in the diary pages without restriction. You may change calculations and formats but if you do so, you must indicate that the spreadsheet is based on my copyrighted design and you have altered it. Please send me a copy of any innovations you make using the diary web link.

Job planning – what they say
I have written this diary to support the process of job planning. It is important to remember that there are various other inputs to a job plan meeting other than a work diary. In the same way that a list of DCC sessions does not make a job plan, a workload diary is not the only input. Nevertheless, a robustly-completed workload diary is evidence that your employer will find very hard to dismiss if you do not agree on the amount of work that you are doing.

You are not expected to deliver the same work performance week in, week out. The diary should be averaged over a representative period, and weekly totals might vary widely depending on the exact work content of that week. You should keep a diary over a sufficient number of weeks to fairly represent your work commitment.

The BMA believes that diaries are central to the process.

“Over the first few months of the job you should keep a work diary to ensure that your job plan accurately reflects the nature of your post. Where there is a significant disparity then an interim job plan review can be requested to review this. This is even more important for new posts where there is little or no precedent to predict workload…

“When you come to review your job plan at an interim meeting or at the annual review, you should ensure that you have a clear idea of whether or not the existing job plan accurately reflects the work you actually do. Keeping a diary of your workload will be vital for this.”

CCSC, Job Planning: A summary for consultants new to the 2003 contract in England and Northern Ireland, September 2004

Some employers have difficulty accepting that consultants work as hard as they say they do, or that there is any evidence that can justify extra recognition. The purpose of the diary is to provide that evidence.

The Modernisation Agency produced guidance in 2003 to support the launch of the agreed job planning diary:

“The following diary has been adapted from that prepared by the British Medical Association’s Central Consultants’ and Specialists Committee for the survey on hours of work and pattern of working that took place during 2001. It has been tailored to reflect the definitions of work and out of hours as set out in the ‘Heads of Agreement’ and consultant contract framework agreement.

“The purpose of the diary is to help you develop your NHS job plan. You may find it helpful to note down when you are undertaking private practice or other additionally remunerated work, particularly work of this nature that is irregular. If, however, you prefer not to do this, you do not need to do so.

“Predictable emergency work (e.g. post take ward rounds) should be programmed where possible into the working week and count towards your programmed activities. Less predictable emergency work should be handled, as now, through on-call arrangements. For this reason, you may wish to distinguish between predictable and unpredictable on-call duties in your diary.”

You are not expected to produce a detailed diary every year:

“Except for newly appointed consultants, the job planning process needs to start from a review of the current job plan, but in the light of future service needs. In other words, what is the individual or team doing and will it meet the future requirements of the population served. This may be supported by the use of activity records or diaries. These data should be used to develop prospective job plans for teams and individuals. Where team plans are developed these should be converted into individual job plans, with the addition of personal objectives…

“The use of diary exercises should not be considered the norm for the majority of Consultants undergoing Job Plan Review.”

CCIT Guide to Consultant Job Planning v4.0, 1 November 2004

Upgrading from previous versions
Generally, upgrading from previous versions of the diary is easy and should involve no more than two copy/paste operations per week in the diary. You may also want to review the diary after upgrading because the version 6 diary adds a
Consultant job planning diary v6.3  Operating manual

number of features which can only be used if you enter new codes or otherwise customise the diary.

Version 6 includes premium time three-hour PAs, part time calculations and medical academic codes.

You will need to paste the contents of the diary slots and the day slots separately, and add the date for the Monday of the week.

Diary slots
Cells B5:O52 contain the diary slots. Highlight these cells and copy them in your old diary. Move to the new diary at cell B5 and select ‘paste special’ on the Edit menu. Click on ‘values’ and then ‘OK’. This will preserve the formatting in the new diary which is essential for the premium time functions to work properly.

Then select K57:O58 in the old diary and paste in the values as above. Using ‘paste special’ will preserve the bank holiday formats in the new spreadsheet.

Other adjustments
You then need to set the date of the sheet by entering the Monday date into the buff box.

Finally, you can rename the worksheet to that same date (e.g. ‘16 Jan’) by right-clicking on the sheet tab. This helps to keep track of the pages in the diary. It is important though to remember that all calculations are done only on sheets between ‘Start’ and ‘End’, and those sheets must retain those names.

Versions
Version 6.1 differs from version 6 in that I have corrected a minor display bug. In version 6, unpredictable on call work performed on a bank holiday during the day was not coloured dark green to confirm its status as premium time. The calculations were still carried out correctly. This was due to a small error in conditional display formatting. If you wish to paste the corrected formats into your version 6 spreadsheet, select cells B5:C28 on the version 6.1 weekly page, copy them and move to cell B5 of the weekly page of your version 6 weekly page. Select ‘paste special’ on the Edit menu and paste the formats only. Paste these formats into every weekly page in your old diary.

Version 6.2 corrects a minor display bug – no change to counting.

Version 6.3 removes one of the major potentials for rendering the diary inoperative. The contents of the ‘Start’ and ‘End’ sheet have been removed so as to remove the temptation to copy these sheets and use them in the diary. Just enter data in the sheets between ‘Start’ and ‘End’.

Completing the diary
On the diary pages, enter the date for the Monday in the buff box. Dates for the rest of the sheet will be calculated from this.

Mark the job code columns with the appropriate code taken from the list on the right side of the page. If the duty was performed while on call, mark ‘1’ or ‘2’ as appropriate in the ‘On call?’ column, as well as putting in the job code. Make sure you enter ‘W’ or ‘L’ in each half day for the working week.

I have designed the diary to work with code entries in upper case. I think it will work with lower case, but I can’t guarantee this.

In general, I have tried to make diary completion easy and intuitive. However, you must appreciate that it is not foolproof. I have used the considerable programming powers within Excel to produce a very open diary – what you see is what you get, and all the formulae are open to inspection. The diary is also user-configurable in several ways.

This means that it is possible to enter false information in the right place or true information in the wrong place, or copy and paste wrongly. If you do this, you will get inaccurate analyses. All use of the diary is at your own risk.

I may be able to answer queries about the diary (and I would like to hear if you have found a problem or if you find it particularly useful) – email me using the diary web link.

Short breaks
Lunch and other short breaks remain a matter of contention. My practice is to record lunch breaks only when I have a definite break and have been able to leave my duties to take it. This is usually only when I am working on SPAs from home. When in the hospital, consultants take necessary refreshment breaks when they can, and are not able to hand over their duties to a colleague while taking a break. This professional way of working is recognised by the fact that consultants do not (and should not, according to their contract) clock off for lunch breaks.

This leaves the question of how to record time slots. Breaks may be taken at convenience - sometimes long, sometimes short, and on occasion non-existent if giving emergency care. And they are paid during them. And of course if one is paid during a break, it is included in the hours worked.

If the hours surrounding a break are direct clinical care, a reasonable break is direct clinical care. If the hours surrounding a break are supporting
professional activities, a reasonable break is supporting professional activities.

**Adding more weeks**

You must keep the sheets 'Start' and 'End' at the start and end of the week pages in the tab line below. All summation and calculations are done on the week sheets between these two tabs. It does not matter what order the sheets are between the Start and End tabs.

To add more weeks:
- Select a week sheet and use 'Move or copy sheet...' on the 'Edit' menu.
- Then check the box for 'Create a copy' and insert the copy before the 'End' sheet.
- Rename it appropriately using Right-click.
- Existing data in the diary slots can be deleted using the 'Delete' key or the 'Delete...' option on the 'File' menu.
- Do not use 'Clear' as you might accidentally clear the formatting information on which the premium-time functions depend.

It is important to follow these instructions precisely.

Delete unwanted weeks - not 'End' - using 'Delete sheet' on the 'Edit' menu.

**Job codes**

The job codes are taken from the job planning documentation produced by the Department of Health and the British Medical Association when the consultant contract was agreed in 2003. (They are described as work codes in those documents; I use the term 'job codes' because of a technical issue with the autocomplete option in Microsoft Excel.)

Each half-hour slot should be recorded according to one or other of the codes, which follow the contractual headings of direct clinical care, supporting professional activities and so on.

Use the left-hand column for each day, headed 'Job code'. If you do not, then the job code will not count towards any totals.

I have made one change to the codes, in that I have added S8 – general administration. This is because I have found that it is often impossible when dealing with an inbox of emails, for example, to categorise how a particular time slot was characterised with reference to the other codes.

Do not change the field names except as below.

**User-definable fields**

The eight fields C12, C13, S9, S10, A6, A7, D6 and D7 are supplied as user-defined. It is important to change the field name only on the Details worksheet. This change will then be reflected through the entire diary.

You may wish to record critical care or labour ward sessions separately, or you may have agreed to take on a particular responsibility such as planning a new hospital, or you may be a college tutor. The user-defined codes will allow you to keep track of the time spent on such activities. Remember to put them within appropriate broad classifications: the four examples above might sit within direct clinical care (C), supporting professional activities (S) or additional responsibilities (A) respectively.

**On-call working**

Mark ‘1’ or ‘2’ against job codes in the ‘On-call?’ column for each day. This refers to predictable or unpredictable on-call work. See the national contract documentation if you are unsure which is appropriate.

The job codes for on-call work are counted in the normal way. The diary will then count ‘1’ and ‘2’ separately to report on the amount of time allocated to each of these activities.

Please note that it is possible to put numbers down without allocating a job code. The job code counting will be accurate but the on-call classification will not be.

The diary assumes that all ‘1’ and ‘2’ codes refer to direct clinical care (including public health, travelling time and so forth as agreed nationally).

**Substituted clinical time**

The diary allows you to record the situation that you have presented for clinical work but you have been allocated to other duties. This might be because your DCC has been replaced with compulsory audit, your operating list has no patients because of a bed crisis, or you have been asked to lecture to medical students instead of a specific clinical session.

It is important to record substituted clinical time because otherwise your performance against your employment contract will be unable to match what you have agreed, through no fault of your own.

Record substituted clinical time by placing an ‘X’ in the on-call column, against the SPA or other appropriate code in the ‘job code’ column. This time will be reported separately on the front page summary – it is not part of DCC but for the purposes of job planning it is time that you have tried to deliver to the best of your ability.
You should note that this is not an agreed part of the contract documentation. Without it however, there is no way to record accurately time diverted at your employer’s request.

**Premium time**

Premium-time periods are marked in the diary pages as green. This is between 19:00 and 07:00 the next day, and all day at weekends and public holidays. Work done in the premium time periods is counted at the rate of three hours to one PA, instead of four.

However, not all work done in that time is counted in this way; for example, you might choose to do a private session in the afternoon and catch up the agreed SPA work in the evening. That sort of flexibly-shifted work does not attract the premium rate.

So in order to be classed as premium-time work in this diary, job codes must be tagged with a symbol in the ‘On-call?’ column.

1. Any clinical work tagged with ‘1’ or ‘2’ is counted at a premium.
2. Any substituted clinical time tagged with an ‘X’ is counted at a premium – this replaces clinical work that you had agreed to do in premium time.
3. Any other job codes tagged with a ‘P’ is also counted at a premium. This allows you to designate any work done outside core time as being at a premium.

In order to confirm that you have entered premium time correctly, the diary slot will turn dark green for all premium-rated work. The calculations pages will count this work in hours as normal but the conversion to PAs takes place at the rate of three hours per PA.

You cannot enter premium-time work except in a premium-time period. Work done during weekdays and tagged ‘1’ for example, will count at a premium only if you designate the day as a bank holiday.

Columns X:AL contain interim calculations for premium time and you should not enter anything into those cells or change them in any way.

**Payment for premium time work**

Under the provisions of schedule 7, paragraph 3 of the Terms and Conditions of Service: “If, by mutual agreement, a Programmed Activity in Premium Time lasts for four hours or more, an equivalent enhancement to payment may be agreed.” If you have agreed to receive the enhancement to payment you should not also report your work with three hours per PA. This diary is not designed to be able to monitor this (rare) option. You should keep a separate record of your premium time work and make any necessary adjustments.

**Compensatory rest**

The collective national agreement for senior hospital doctors, implementing the Working Time Regulations (1998), provides that where prescribed rest periods have been significantly interrupted, the doctor should take compensatory rest. This is not counted as annual leave. It is good practice (though not mandatory) for such compensatory rest to be taken immediately after the end of the working period.

In practice this may arise if you are busy with urgent clinical work at and are not able to fulfil your clinical duties the next day without placing patient safety in jeopardy.

Compensatory rest is actually a form of leave, even though it is granted at short notice. When taking compensatory rest, you have been authorised to be absent from your workplace and your duties. (‘Work’ is defined as an activity in which one works at one’s employer’s disposal and carrying out one’s activity or duties.) You should enter leave in your job planning diary as if it were annual or study leave – you are absent and that period counts neither to the denominator nor the numerator. See under ‘Recording working days’.

If the leave is less than one half day, and you read journals and catch up correspondence instead of doing a list, for example, then mark this activity accurately and remember to include an ‘X’ for substituted clinical time. If you do not do this this then you will be apparently underperforming on your clinical commitments.

**Additionally-remunerated work**

This work includes anything for which you are paid a separate fee from your base contract. The conditions surrounding such activity in the consultant contract are complex and you should refer to them carefully.

Basically, if you do a waiting list initiative, private session or extra clinic etc., this work counts as additionally-remunerated work and you should not record this work as NHS work. You have agreed to make up the time taken on such work at another time. Work recorded with the P1, P2 and P3 codes is counted for reporting purposes (on the Details page) but not reported as part of your weekly PA average on the front page.

You should also remember that unless on approved leave, you have agreed to perform a certain amount of NHS work over any given period.
If you have a private session on Thursday afternoon, for example, you may have agreed with your employer that this time is protected for private purposes according to the contract. However, you still need to record Thursday afternoon as a working session in the diary (unless you have genuinely booked leave on that day). This is because the number of days worked in the week is used to calculate the weekly PA averages, and I have used a ten-session Monday to Friday week as the basis for determining leave (see ‘Recording working days’ below).

**Non-work activity**

Non-work activity is recorded using the N1 and N2 codes. These are part of the original contract documentation. The diary does not count or analyse N codes and you may find it easier to leave the fields blank when not working.

**Adding up programmed activities**

Each weekly sheet is analysed for the total of the hours worked for each job code. This total is turned into a number of PAs using a conversion factor of either three hours or four hours per PA depending on whether the time is premium time or not.

Summation across the pages is done to the Details and the Summary pages using Excel commands that can cross a range of worksheets. The most important thing to understand is that the data must lie on the Start and End pages, and any in between, to be counted. Data outside that range will not be counted. It is also necessary to make sure that all the diary pages are identical – adding in extra rows and columns will throw out the calculation ranges and invalidate the results.

**Producing an average**

The number of working days and weeks is summed across diary pages in the same way (see below for detailed description of how to enter this information).

With both numerator and denominator, the one is divided into the other to produce the weekly averages. This is done for each job code on the Details page, and then the overall total sin the contract categories are produced on the Summary page.

The summing is done before the division. This is so that work done during a week of leave, for example, is recorded in the overall averages even though the work done that week cannot be averaged as there were zero working days.

The Summary page gives the date range over which the diary runs. This is determined simply by looking at the oldest and newest dates to be found in the diary and has no impact on the calculation of averages.

**Recording working days**

The cells K57:O58 on each diary page should be used to record whether that particular half-day was W (work), L (leave), BH (bank holiday) or NW (not working, where weekly contracted PAs are less than 10 – see ‘Part-time contracts’ below).

This is used to calculate the proportion of the working week that you have agreed to work that week. For example, if you have a ten-PA contract, but two days leave in one week and so work only six PAs in that week, this mechanism forces the assumption that you work three days in that week, or 0.6 weeks. The six PAs and the 0.6 weeks are both added to the numerator and denominator respectively for the calculation of the average weekly PAs.

It is important to fill in all the ten boxes with one code or another for a complete week. The worksheet will remind you to do this.

You should note that this is not an agreed part of the contract documentation. Without it however, there is no way to calculate the average number of PAs worked in a week, unless the diary excludes all weeks in which any leave of any sort was taken. You can choose to do this anyway, and if you do then this denominator information will become irrelevant.

**Bank holidays**

Bank holidays are recorded separately from leave because this affects premium-time calculations. For example, if you were recalled for an emergency on a Monday morning when you had been granted leave, it would not count as premium time. However, were Monday a bank holiday and you were recalled, it would count as premium time.

If you enter ‘BH’ into the sheet for the morning session, the bank holiday status will be confirmed by a green background. Please note that you can enter this in the morning and ‘W’ in the afternoon; this would be nonsensical and so take care to avoid it.

**Part-time contracts**

Determining the denominator (the number of worked weeks) for part-time consultants is difficult and there is no one best way. I have assumed and used a reasonable method. If you are at all concerned about your bespoke contract and the ability of this diary to cope with it, you should consult your trades union or professional association.
You should enter the number of PAs for which you are contracted. For example, if you are contracted for eight PAs per week, enter ‘8’ in the box under your name on the ‘Summary’ page (cell B4). This will appear as ‘80%’ in cell D9 and this will be reflected through to every page in the diary. This figure is used only for the denominator; it is used to calculate the proportion of the working week that you have done.

Then enter the days worked as appropriate in the box of half days. This will be compared against the contracted PAs to determine the proportion of a week that you have worked.

For example, if you are a full-timer and record three days work in one week, you have only worked 60% of a week; however, if you are a six-PA part-time consultant and you have done the same, you have fulfilled your weekly commitment and worked 100% of a week. Since these percentage figures are then used to compare your recorded working hours against your contracted hours, it is important to get them right.

You should note that this is not an agreed part of the contract documentation. I have used one of the commoner methods of counting part-time work commitments. Without some method however, there is no way to calculate the average number of PAs worked in a week on a part-time contract.

**Additional programmed activities**

You should not enter APAs here. They will not be carried through to the contribution to the number of weeks worked.

If I did not assume this, then there would follow the perverse result that you could never perform your contracted work, since a full working week would be recorded as less than 100% of a week.

If you have contracted for APAs, the diary will record accurately whether you have delivered or exceeded your average weekly commitment.

Therefore, for all contracts of ten PAs per week and above, you should enter ‘10’ in cell B4.

**Clinical academic work**

The job planning diary incorporates the means for analysing consultant work as a clinical academic. The provisions for this are taken from the Terms and Conditions of Service for the NHS consultant contract, schedule 23; so, for example, the provisions of premium time apply.

I have taken the diary codes for university work from “The Clinical Academic Consultant Contract (England) 2003: BMA Advice on Integrated Job Plans”, January 2004. If you are a clinical academic, you should get a copy of this document from the BMA web site.